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CHAPTER 1 GETT'NG TO KNOW M|CROSOFT WORD
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Microsoft Word is a word processing application that is usually part
of a suite of Microsoft applications, known as Microsoft Office.

You can use Word to create all sorts of documents, including
letters, reports, faxes, forms, emails, web pages, invitations and
certificates.

Before you leap into creating anything, it is worth taking some time
to become familiar with the Word window and its features.

In this session you will:

v/ gain an overview of the meaning and origins of word
processing

v/ gain an overview of the common types of documents that
can be word processed

v' learn how to start Microsoft Office Word 2010
v' gain an understanding of the Word 2010 screen

v/ gain an understanding of how Microsoft Word 2010
' works
| v" learn how to use the Ribbon

v' learn how to use the keytip badges on the ribbon

v'gain an understanding of Backstage View in Microsoft
Word

v"learn how to use shortcut menus

v/ gain an understanding of how dialog boxes work

v'gain an understanding of the Quick Access Toolbar

v/ gain an understanding of the status bar

v"learn how to exit correctly and safely from Microsoft

Word 2010.
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UNDERSTANDING WORD PROCESSING

Every facet of our everyday existence is chosen words. The ability to create these
controlled by the written word. We receive documents, to change them, to enhance the way
information, follow instructions and record events, they look, and to print them is what is now referred
often using documents that consist of carefully to as word processing.

Word Processing — A Definition

Word processing refers to the ability to create, edit and store text, and to reprint it as many times as
desired. Word processing is used to create a multitude of personal and business documents, such as
letters, memos, faxes, reports, books, essays, brochures, flyers, price lists, and the list goes on!

The Roots of Word Processing

The desire for humans to communicate in writing can be traced back to our cave dweller ancestors who
painted images of hunting and everyday life on cave walls. Who knows, these might even have been the
first training manuals or reports on hunting expeditions!

The ancient Egyptians used writing to record commercial trading transactions. Initially using clay and
stone, they then invented writing on paper, or papyrus, to speed up the process of writing.

In 1492 Johannes Gutenberg invented the world’s first printing press which allowed one document to be
produced and disseminated many times. Many historians attribute world-shaking events such as the
English, French and American revolutions to the invention of printing and the communication of ideas.

The printing press marked the beginning of using machines to produce writing. This idea of using
machines for writing was kicked on in 1873 when Christopher Latham Scholes invented the first
commercially-practical typewriter. This typewriter was marketed by the Remington Arms company.
Earlier experimental typewriters used an alphabetical keyboard. However, the action of the type bars in
these machines was sluggish and the bars tended to jam. Scholes developed the QWERTY keyboard so
that letters used in combination were further apart, therefore allowing more time for the type bars to
return to their normal position and avoid jamming. In 1878 ten-finger typing was established using the
QWERTY keyboard — essentially, this has meant that the QWERTY keyboard has survived to this day
even on modern computers.

Typewriting gained enormous popularity in offices around the world in the first half of the twentieth
century. New office procedures and jobs were created around the typewriter — many organisations had
special typing pools, which consisted of teams of people (usually young women) typing documents.

In 1961 IBM introduced the Selectric typewriter. It was an electric typewriter with fewer moving parts than
a manual typewriter, and was much faster to use. In 1964 IBM released the Magnetic Tape Selectric
Typewriter that allowed typed information to be stored and retrieved. This machine was marketed as a
word processing machine because for the first time text could be stored, replayed (typed automatically
from the tape), changed and printed as many times as required.

In 1972 Lexitron and Linolex introduced the first modern word processing system which displayed
documents on a screen rather than on paper. This machine stored the documents on cassettes. The
screen allowed text to be entered, rearranged or deleted without the need for producing a paper copy.

In 1973 IBM released a new word processing machine that stored documents on floppy disk. Early
storage systems could hold only several pages. The floppy disk allowed the storage of large, multi-page
documents. The word processors were special machines designed specifically for producing documents.

In 1981 IBM released the IBM Personal Computer which used floppy disk storage technology. This was
one of the few machines ever invented in history that had no specific purpose. It soon became apparent
that the programs used in word processing machines could be stored on floppy disk. Once stored on
floppy disk they could be used in personal computers, thus converting the personal computer to a word
processing machine.

This concept has grown and is the underlying basis of modern word processing. Programs such as
WordStar, DisplayWrite, WordPerfect and later, Microsoft Word, emerged, allowing the personal
computer to produce documents with a size and complexity far greater than earlier machines. Today,
virtually all word processing is done on personal computers using word processing programs.
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The first word-processed documents were
business documents such as letters, memos and
reports. With the development of screen and print
technologies, it is now possible to use word
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TYPES OF WORD-PROCESSED DOCUMENTS

processing software to produce a much greater
variety of documents such as brochures,
newspapers and newsletters, greeting and
business cards, and more.

Type Characteristics Intended Audience
Letters Letters are usually one or two pages in length and consist Business associates, customers,
mostly of text suppliers, friends, relatives, etc
Memos Memorandums are internal business documents that Fellow employees, management,
usually consist of one or two pages of text subordinates
Faxes Faxes are documents transmitted over telephone lines. Business associates, customers,
They are usually brief and are used to convey information suppliers
quickly and succinctly. Faxes can be printed and sent from
a fax machine or they can be sent in electronic format
directly from a computer connected to a telephone line
Reports Reports are normally multi-page documents providing Business associates, clients,

Briefing Papers

Minutes

Essays and
Assignments

Training Manuals

Books

Brochures

Newsletters

Flyers

Emails

information or findings of an investigation or survey to the
reader. They usually consist of text. Long reports may also
have a table of contents and an index

Briefing papers are documents that provide background
and useful information regarding an historical or upcoming
event

Minutes records what officially went on in a meeting. They
can be informal or formal and basically describe what was
discussed, what decisions were made, what actions need
to be taken, and who is responsible for carrying out those
actions

Essays and assignments are normally multi-page
documents conveying ideas, opinions or research findings.
They mostly consist of text

Training manuals are normally multi-page documents
designed to instruct and inform. They range from mostly
text to highly structured documents. (Note: this publication
was produced using Microsoft Word)

Books are multi-page documents consisting mostly of text.
They have a table of contents and usually an index

Brochures are mostly laid out with graphics and text. They
are often no more than several pages in length.
Increasingly, these are transmitted electronically via the
internet

Newsletters are used to convey news, updates and
activities for clubs, groups, organisations, products, and the
like. They are organised into columns and consist mostly of
text

Flyers are normally one-page information sheets that are
highly graphical and structured advertising a product or
event

Emails are usually short letters sent via the internet or
through a computer network

management, creditors,
shareholders, general public,
community groups, etc

Sales people, managers,
committee members, company
board members, etc

Attendees and other interested
parties

Teachers, lecturers, mentors

Course attendees, people
wishing to acquire new skills and
knowledge, people wishing to
gain a qualification or
accreditation

People seeking information
and/or entertainment

Clients, potential customers

Clients, customers, general
public, club members, etc

Clients, potential customers, club
members, etc

Anyone with an email connection
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STARTING WORD

To create a new document, or edit an existing
one, the first thing that you need to do is to start
Microsoft Word. As a standard software
application, how Microsoft Word is started is
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largely determined by Windows. For example, it

can be started from the Windows Start menu, from

a shortcut, or even by opening a document that
was created in Word.

Try This Yourself:

Before you begin, ensure
that your computer is
switched on and that the
Windows desktop is
displayed on your screen...

Note

o Click on the Windows Start
button at the bottom left-
hand corner of the screen
to display the menu

It’s a round button with the
Windows logo...

Click on All Programs
Click on Microsoft Office

Click on Microsoft Office
Word 2010

After a few moments a
blank document will appear
in Word 2010

Getting Started
9

g Windows Media Center Eriu

- Calculator

Documents
Pictures
Sticky Motes

Music
Snipping Tool

Garnes

it Paint

»

% Remote Desktop Connection
=
W

Computer

~ Control Panel
Magnifier
Devices and Printers

Solitaire
Default Programs

Help and Support

All Programs

| |Search programs and files

i
o
i
i

Maintenance

McAfee Security Scan Ed Smith
Microsoft Developer Network

Microsoft Office Documents

”‘o Activation Assistant for Microsoft O

[&] Microsoft Access 2010 Pictures
(] Microsoft Excel 2010

@ Microsoft InfoPath Designer 2010
@ Microsoft InfoPath Filler 2010

@ Microsoft Office Project 2007

[E) Microsoft Office Visio 2007

@l Microsoft OneMote 2010

(@] Microsoft Outlook 2010

Microsoft PowerPoint 2010
Microsoft Publisher 2010

@ Microsoft SharePoint Workspace 201
Microsoft Word 2010 Default Programs
! Microsoft Office 2010 Tools

! Microsoft Office Tools Help and Support

4 Back

Music

Garnes

Computer

Control Panel

Devices and Printers

| ‘Searrh programs and files m

For Your Reference... Handy to Know...
To start Microsoft Word: You can also start Word by:
1. Click on the Windows Start button e Double-clicking on a Word shortcut
2. Click on All Programs  Double-clicking on a document file icon in a
3. Click on Microsoft Office file listing
4. Click on Microsoft Office Word 2010 e Choosing a document from the Recent

Items list on the Start menu.
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THE WORD SCREEN

The Microsoft Word 2010 screen is made up of other Office 2010 applications so once you know
several key components which are described on how they work you won’t have to relearn them
this page. Some of these components, such as when you use other applications.

the Ribbon and Backstage, are common to all
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The Ribbon is the tabbed band that appears across the top of the window. It is the control centre of Word
2010. Instead of menus, you use the tabs on the Ribbon to access the commands that have been
categorised into groups. The commands include galleries of formatting options that you can select from,
such as the Styles gallery shown here.

The File tab is used to access the Backstage view which contains file management functions, such as
saving, opening, closing, printing, sharing, and so on. Word Options are also available so that you can set
your working preferences and options for Word 2010.

The Navigation pane lets you view all of your document’s headings and pages; locate and restructure the
content by dragging headings; and find all instances of specific words, phrases or items such as figures and
tables — without having to scroll through the search results.

The Insertion point shows where the text will appear if you start typing.

The Mouse Pointer is used, amongst other things, to move the insertion point to different locations in the
document. It may appear as a pointer or an I-bar, as in this example, or any number of other forms,
depending upon its function at that position on the screen.

The Status Bar appears across the bottom of the window and displays the current location of the insertion
point, including page number, section number, column, and so on. It can also be used to access navigation
commands such as Go To.

The View buttons and the Zoom Slider are used to change the view or to increase/decrease the zoom ratio
for your document.

The Scroll bar indicates your current position in the document and lets you move to other positions in the
document by clicking or dragging. The arrows can also be used to move through the document.
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How MICROSOFT WORD 2010 WORKS

For a new user the Word 2010 screen may seem
tricky — particularly the commands area at the top
of the screen. The screen comprises three key
areas. The data you type is placed on a page.

The data can be manipulated using commands on
the Ribbon. The page is part of a larger entity
known as a document or file, and everything you do
to the file is controlled in Backstage view.

The Page

If you create a new blank document, it will
appear as a blank page in the document
window with a blinking insertion point. When
you start typing, the text will appear at this
location. You can also create a new
document from a template, such as this
resume shown to the right, where specific
information will appear by default in the page,
and you can edit it and add your own data as
desired.

The Ribbon

Mary Bartlett

123 Main Street Box Hill IC 3128
03 9890 0000
marybarten@gmailcom

EDUCATION

Nov 2003
Bachelor of Arts

SKILLS

O Editing
O Bxrensive experience with PCs
O Working with people.

When you need to do something with the data on a page, such as format it, colour it, move it, copy it,
and much more, you’ll find all of the relevant commands on the Ribbon. The Ribbon has the
commands organised thematically using a series of tabs across the top.
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. Save As
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boss, protect it from prying eyes, or
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the Microsoft Office Backstage
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USING THE RIBBON

The Ribbon is the command centre for Word. It
provides a series of commands organised into
groups that are placed on relevant tabs. Tabs
are activated by clicking on their name to display
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the command groups. Commands are activated by
clicking on a button, tool or gallery option.
Everything you could possibly want to do in Word
will be found somewhere on this Ribbon.
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at the bottom of the list...

Click on each of the tabs and
examine the commands

Some of these open dialog
boxes...

On the View tab, click on
Zoom in the Zoom group to
open the Zoom dialog box

Click on [Cancel] then click
on the Home tab

% 108 AD g2

Stars and Banners
R NSRS GEITMmy
TR

@ Mewy Drawing Canvas

P

For Your Reference...
To use the Ribbon:
1. Click on a tab to display the commands

2. Click on a button to activate a command,
display a gallery or display a dialog box

Handy to Know...

e Additional tabs known as Contextual tabs
appear in specific circumstances. For
example, if you insert a picture, the Picture
Tools: Format tab will appear. This provides
quick access to all of the tools you may need
to modify and work with the picture.
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USING RIBBON KEYTIPS

The Ribbon is normally accessed with a mouse.
However, you can also use the keyboard to

access Ribbon commands. When you press [ait],

the letters known as key tips or access keys,
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will appear next to commands on the ribbon.
Pressing a key on the keyboard will activate the
corresponding command on the Ribbon just as if
you’d clicked the command with the mouse.

(1 JOif g8
q = 3
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For Your Reference... Handy to Know...
To use KeyTips to access commands: e You can still use the shortcut keys for menu
1. Press [ait] to display the KeyTips com_mands tha_t were available in previous
versions of Office. For example, [cu1] +|8 ]
2. Press the letter key of the command or tab .
that you want to select applies bold to selected text.
3. Press to return to text entry mode
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UNDERSTANDING THE BACKSTAGE VIEW

The Ribbon lets you work on the content in a
document — you can add more content, format it,
insert pictures into it, copy it, and much more.
The Backstage view, which is accessed using

the File tab, lets you do something with the content
you create. You can save it to use it later, print it on
paper, send it via email, and more, using the
options found in Backstage view.

The Backstage View @da- o= Focumene M crorere Werd B
. . . File Hame Insert Page Layout References Mailings Review Wiewy ) e
The File tab on the Ribbon is not - = <
Saue
a normal tab — as you can tell by Print =
o . : B save as @3
the fact that it is coloured. Clicking o Copies: 1 =
. « . pen .
on the File tab launches a mini- = PlsE

program within Microsoft Word
known as Backstage View.
Backstage, as it's known for
short, occupies the entire screen
although the tabs from the
Ribbon still remain visible across
the top.

Info
Recent

Mew

Share

Help

At the left of the Backstage is a
navigation pane which is made up
of Quick commands, smallish
buttons which will perform an
operation immediately, and
largish tabs, which display more
options and information to the |
right of the screen.

@ Qptions

Exit

The whole underlying purpose of
the Backstage is to let you

Printer

;7 HP Colar Laserlet CPA005 P.., -
) Offline

Printer Properties

Settings

B

Pages:

Print &ll Pages
Prinit the entire docurnent

Qnly print on one side of th.., 7

E@ Collated

123 123 123

B
Portrait Orientation

Letter
2158 cmx 21,94 cm

1; Custarm Margins
IDI 1Page Per Sheet

Page Setup 41 lofl »

41% (=)—L—

®E

protect your data, share it with
others, and provide you with

Quick Commands

The Quick commands provide immediate
access to an operation.

Q Sawe

Save A

Saves the current document

Allows you to save the current
document under a different name
or location

Opens a previously saved
document

ﬁ Qpen

Closes the current document

' Close

Provides access to options that
allow you to control how Word
looks and works

|:j Qptians

Allows you to close and exit
Microsoft Word

Exit

Backstage Tabs

The Backstage tabs provide more options for
working with a document

Provides status information about
the current document and lets you
manage versions and permissions

Info

Provides a list of recently saved

Recent documents

Lets you create a new document
and provides access to a huge
gallery of templates

Lets you print the current
document and also previews it

- Lets you share your document
Share with other people

Provides access to Microsoft's
help network and also provides
licensing information about your
software

Help
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USING SHORTCUT MENUS

In addition to the Ribbon, Word also features where you click. Shortcut menus provide an
shortcut menus that appear when you right-click alternative, usually a quick one, to trudging through
in an area on the screen or on an object. The the Ribbon to find a specific operation or
content of the menu will vary depending upon command.
] 0 Calibri[E» |11 = | &S 47 €= iF
Try This Yourself: B/USW-A-F
(] = g .
T  Before starting this exercise Cut
S ensureyou have a blank By Copy
8' document open... [, Paste Options:
o Move the mouse pointer to the A | rom
middle of the document and el
click with the right mouse =T | Earagraph..
button to display a shortcut or = oBulets |
contextual menu §= Mumbering | ¥
Because you have clicked in A ses | ’
the body of the document the & tHyperink.
menu mcludes. Font and lockUp |
Paragraph options. As no text L
. YNORYMS b
is actually selected the Cut, B2 Transiat
Copy and Paste options are ® | TEnaee

greyed out...

Click anywhere on the page o ﬁ il & »\:3 Customize Quick Access Toolbar..,
with the left mouse button to = |: Show Quick Access Toolbar Below the Ribban I;[
fl

close the shortcut menu

Print |Full Screen tustamize the Ribban.. 10r

Move the mouse pointer over EYENY Reading L Minimize the Ribban
any of the tabs on the ribbon ELLEU T Ere | n i
Mavigation * X

Right-click on a tab to display
a shortcut menu Search Document 2o~

g | E > 5

Notice how it differs from the
previous menu and displays a
toolbar and ribbon options
instead of text. Word has
made an educated guess
about what you want to do
based upon what you have
clicked...

e Click anywhere on the page
with the left mouse button to

close the shortcut menu

For Your Reference... Handy to Know...

To display a shortcut menu: e Once a shortcut menu appears, the options

1. Point to the object or area of the screen on in it are selected by clicking on them with the
which you want to perform an operation left mouse button, or pressing the letter

2. Right-click to display the shortcut menu Uil = I LD i CIET:
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UNDERSTANDING DIALOG BOXES

Dialog boxes contain a series of controls that are
used to adjust settings for a particular aspect of a
document. They appear either when you click on
a dialog box launcher || at the bottom right

corner of a group, or when you click on a command
that displays a dialog box. Dialog boxes are often
used for adjusting some of the more advanced
aspects of a document.

Typical Dialog Box Controls

Dialog boxes have various tools to help you perform tasks. These tools are known as controls and

some typical ones are shown below.

-

Font

m Tabs are used to

—'—lFont — pr0\_/|de more
- = settings on the one
dialog box.

Text boxes Fant: Fant style: Size:
are used to . 11
enter text such - N AT
as font or size. ;g:;;jlgg:lon Pron D IBtDE:chIc ?D D

Adobe Caslon Pro Bold Bold Italic \ il

Adabe Fangsang Std R 2 = Drop arrows provide a list

Fant color: Underline style: Underline color: of options for the text box
Check boxes | Sukamnatic El |(nc-ne) EI | Sukarnatic El when the arrow is clicked.
turn settings Effects The list “drops down” from
either on or off. Strikethrough Shadow Small caps the arrow.
When on they Double strikethrough Outline All caps
dlsp|ay a tick EI Superscripk Ermboss Hidden
and therefore Subscript Engrave
these controls Previsw Preview boxes provide
are also known a preview of what the
as tick boxes. — +Body selected settings will

This is the body theme font, The current document therne defines which Font will be used, look like.

Set As Default ] I Text Effects. ..

[ Ok ][ Cancel ]

Command butt

ons provide a means of saving the

changed settings [OK], or closing the dialog box
without accepting any changes made [Cancel].
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UNDERSTANDING THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar, also known as the most frequently, such as Save, and includes by
QAT, is a small toolbar that appears at the top default the Undo and Redo buttons. You can add
left corner of the Word window. It is designed to buttons to the Quick Access Toolbar to make
provide access to the command tools you use finding your favourite commands easier.

The Quick Access Toolbar

The Quick Access Toolbar is positioned at the top left corner of the Microsoft Word 2010 screen. In
its default state, it includes the Save tool, the Undo tool and the Redo tool.

Page Layout References Mailings

Font ]

Customising the Quick Access Toolbar

Appearing immediately to the right of the Quick Access Toolbar, the Customise Quick Access
Toolbar tool displays a list of commonly used commands that you can add to the toolbar. You can
select the items that you want to add. The ticks that appear to the left of the menu options show you
that an option is already displayed.

I stumize Quick Access Toolbar ENCes Mailings
Pl et
* e
Cali e Tl T
. Open l% H f
F‘aste 3 S ave A - % = = =
Clipboard & E-riail o -
Mawigation Quick Print

Print Prewiew
Search Document

Spelling & Grammar

EE Urndo
Redao

Drrawe Table

This daocument
contain headi

Open Recent File
To create nawig

create heading Mare Cammands..,
document by a
Heading Styles Show Below the Ribban
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